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Preface

This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Referto the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.
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Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

¢ Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machine, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.
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Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

Performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or stablish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.

Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESS
OR IMPLIED, REGARDING MERCHANABILITY, NON-INFRINGEMENT, OR
FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS. ANY BUYER OR
USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE HAS DETERMINED
THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR
INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES,
EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANY, NEGLIGENCE, OR STRICT LIABILITY.

If no event shall the responsibility of INDUSTRIAL SHIELDS for any act exceed the
individual price of the product on which liability is asserted.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.
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INDUSTRIAL SHIELDS

1 General Description M-DUINO FAMILY product

1.1 Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is
important to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the
shield from below and D the shield from above. Having a B and a C in the middle of
them. It can have a minimum of 2 zones (A, B) and a maximum of 4 (A, B, C, D). The
nomenclature is represented on the picture below:

(
=l |

[ LT |

i |
|
- = [ i
w W o o w
Z% %ZZZ
QR . RRRR
1'CZONE
1| BZONE

O om@i.q ' AZONE

e The inputs in the zone B are named 10.X, being X any number suitable in the
Shield. Outputs are named as Q0.X and relays as R0.X

e The inputs in the zone C are named 11.X, being X any number suitable in the
Shield. Outputs are named as Q1.X and relays as R1.X

e The inputs in the zone D are named 12.X, being X any number suitable in the
Shield. Outputs are named as Q2.X and relays as R2.X

1.2  Zone Distribution

A zone is completely common for every single M-Duino Family PLC. The rest of zones
can have two different shields. The two shields that can be in every Zone (except for A
Zone) are the Analog Shield or the Relay Shield. Only 1 Shield is allowed per Zone.

Depending on the combination that is made to build the PLC it can provide more
Analog Inputs/Outputs or Relays Outputs. All the zones (B, C, D) can be one of the two

Shields:
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ZONEA |—»*| ZONEB |——=| ZONEC |— | ZONED

Communication

—>{  Analog

L* Relay

—>  Analog

> Relay

—> Analog

—- Relay

The distribution of the different features that provide the M-Duino Family is the

following one:

Shield B Zone C Zone D Zone
13 Inputs 13 Inputs 11 Inputs
(13 Digital inputs, (13 Digital inputs, (11 Digital Inputs,
6 of which can 6 of which can 4 of which can
work as Analog work as Analog work as Analog
Input) Input) Input)
Analog Shield
8 Outputs 8 Outputs 6 Outputs
(8 Digital Outputs, | (8 Digital Outputs, | (6 Digital Outputs,
3 of which can 3 of which can 2 of which can
work as Analog work as Analog work as Analog
Output) Output) Outputs
6 Inputs 6 Inputs 6 Inputs
(6 Digital Inputs, (6 Digital Inputs, (6 Digital Inputs,
4 of which can 4 of which can 4 of which can
work as Analog work as Analog work as Analog
Input) Input) Input)
Relay Shield
11 Outputs 11 Outputs 9 Outputs
(8 Relay Outputs, (8 Relay Outputs, (7 Relay Outputs,
3 Digital Outputs, 3 Digital Outputs, 2 Digital Outputs,
3 of which can 3 of which can 2 of which can
work as Analog work as Analog work as Analog
Output) Output) Output)
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1.3 A Zone Features

Shield A Zone

(1x) Ethernet

(1x) USB

(1x) 12C

(3x) TTL

(1x) RS-232

Communication | (1x) HALF/FULL Duplex RS-485
Shield (1x) SPI external Port

(1x) RTC

(1x) uSD Socket

This is the list of our products depending on the combination of the shields. As it is
already said above the A Zone is totally common for all the M-Duino Family.

M-Duino B Zone C Zone D Zone

Analog | Relay | Analog | Relay | Analog | Relay

M-Duino 19R+ X
M-Duino 21+ X
M-Duino 38R+ X
M-Duino 38AR+
M-Duino 42+

M-Duino 50RRA+ X
M-Duino 53ARR+
M-Duino 53ARA+
M-Duino 57AAR+
M-Duino 57R+ X
M-Duino 58+

X X
X X

X X X
X X X
X

X
X

>
X
>

The nomenclature of the M-Duino Family products consists on placing the name of the
Shield/s after the total number of I/Os of the product.

For example M-Duino53ARR+ is a PLC with the 3 extra Zones (B, C, D), which are
Analog, Relay, Relay respectively. It has 53 I/Os.

M-Duino B Zone | C Zone | D Zone
M-Duino53ARR+ A R R

* There are 2 different exceptions. M-Duino38R+/M-Duino57R+ should be called with this nomenclature M-
Duino38RR+/M-Duino57RRR+, as everything is Relay it is omitted. Also for the M-duino21+/42+/58+ as
they are all Analog they are not represented with this nomenclature. With the nomenclature represented in
the User Guide they would be: M-Duino21A+/M-Duino42AA+/M-Duino58AAA+
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1.4

119.5

119.5

Mechanical dimension

119.5

101

M-Duino 1 BLOCK I/Os

M-Duino 2 BLOCKS
1/Os

M-Duino 3 BLOCKS
1/Os
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1.5

General Features

CONECTABLE PLC ARDUINO 24Vcc M-DUINO

B+C+D
MODEL TYPE B Zone |B+C Zone
Zone
Fuse protection (2.5A)

Input Voltage 12 to 24Vdc Polarity protection

| max. 1.5A

Size 101x119.5x70.1 | 101x119.5x94.7 | 101x119.5x119.3

Clock Speed 16MHz
Flash Memory 256KB of which 8KB used by bootloader

SRAM 8KB

EEPROM 4KB

Communications

I2C — Ethernet Port — USB — RS485 — RS232 -- SPI
— (3x) Rx, Tx (Arduino pins)

Max232-Max485-
W5500

Type of signals

An/Dig Input 10bit
(0-10Vcce)

0 to 10V
Input Impedance: 39K
Separated PCB ground

Digital Isolated Input
(24Vvcc)

5 to 24Vdc
I min: 2 to 12 mA
Galvanic ISOLATION

* Interrupt isolated
Input HS (24vcc)

5 to 24Vdc
I min: 2 to 12 mA
Galvanic ISOLATION

Analog Output 8bit
(0-10Vcce)

0 to 10Vvdc
I max: 40 mA
Separated PCB ground

Digital Isolated
Output (24vcc)

5 to 24Vdc
I max: 0.3 A
Galvanic ISOLATION
Diode Protected for Relay

Digital Isolated
Output Relay

220V Vac
| max: 5A
Galvanic Isolation
Diode protected for Relay

PWM Isolated Output
8hit (24vce)

5 to 24Vdc
I max: 0.3 A
Galvanic ISOLATION
Diode Protected for Relay

Expandability

12C - 127 elements - Serial Port RS232/RS485

* By using this type of signal can no longer use Digital signal

(24vdc)
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2 Technical Specifications:

2.1  General Specifications:

Item M-DUINO B ZONE M-DUINO B+C ZONE M-DUINO B+C+D ZONE
Power supply
voltage DC power supply | 12 to 24Vdc
Operating

voltage range DC power supply

11.4 to 25.4Vdc

Power
consumption DC power supply 30VAC max.
Power supply 24vdc
External voltage
power supply
Power supply 700Ma

output capacity

Insulation resistance

20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength

2.300 VAC at 50/60 HZ for one minute with a leakage current of 10mA max. Between all
the external AC terminals and the protective earth terminal.

Shock resistance

80m/s2 in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 45°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 445g max. 542g max. 850g max.

2.2 Performance Specification:

Arduino Board

ARDUINO MEGA 2560

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a
programming language. “similar to the C”. http://arduino.cc/en/Tutorial/HomePage

Microcontroller

ATmega2560

Flash Memory

256kb of which 8 kb used by bootloader

Program capacity (SRAM) 8kb
EEPROM 4kb

Clock Speed 16MHz

Clock Speed 16MHz
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3 Precautions

Read this manual before attempting to use the M-Duino PLC and follow its descriptions for
reference during operation.

3.1 Arduino Board

All M-Duino family PLCs include Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate M-Duino according to the performance specifications described in this
manual.

Before using M-Duino under different conditions from what has been specified in this manual
or integrating M-Duino to nuclear control systems, railroad systems, aviation systems, vehicles,
combustion systems, medical equipment, amusement machines, safety equipment and other
systems, machines, and equipment that may have a serious influence on lives and property if
used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and
performance characteristics of M-Duino are sufficient for the systems, machines, and
equipment, and be sure to provide the systems, machines, and equipment double safety
mechanisms. This manual provides information for programming and operating the M-Duino.

4 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Industrial Shields provides boards for programming the PLCs much easier. Basically it is no
needed to define the pins and if that pins are inputs or outputs. Everything is set up
automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.0 or above (better to have always the latest version).
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Steps:
1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences X

Settings  Network

Sketchbool: location:

C:\UsershAlbert\DocumentshArduino Browse
Editor language: English (English) | (requires restart of Arduino)
Editor fonit size: 15

Interface scale: Autmatic | 100 T %  (requires restart of Arduino)
Show verbose output during: compilation upload

Campiler warnings: Nore v

[(pisplay line numbers

[CJEnable code Folding

[#] verify code after upload

[ use external editor

heck for updates on startup

ipdate sketch files to new extension on save ;pde ~> .ino)

Save when verifying or uploading

Additional Boards Manager URLs:  hittp ://apps.industrialshields. com/main/arduino/boards package_industrialshields_inde;| 2]

More prefe an be edited directly in the file

C\Users\Albert\sppDatatLocal\Arduino 15\preferences. txt

(edit only when Arduino is not running)

Ok Cancel

2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

4. Goto: Tools -> Board: ... -> Boards Manager

© skewch_mar16a | Arduing 180
File Ecit Sketch Tools Help

Auto Format Cul+T
Achive Sketch
Fix Encoding & Reload

Serial Monitor Ctil+ShiltsM
Serial Plotter Cul+Shiltsl

WAFi101 Firmware Updater

Boarck "M-Duino family” 3 Baards Manager..
Inchustral Steelcls: “W-Duin 58+ 1 Arduino AVR Boare
( Port Arduin Yun
i Get Board Info Arduino/Genuino Uno
X Programmer: “Artkino 23159 | Ashino Duemilanove or Diecimila

Arcino Nano.

Bum Bootloader

Asduino/Genuano Mega of Mega 2560
Asduino Mega ADK

Arduino Leonardo

Archino Leonardo ETH

Asduino/ Genano Micro

Arduing Esplora

Archino Mini

Arduino Ethernet

Arduino Fio

Ascuino BT

LilyPad Arduno US8

LilyPad Archino

Archuing Pro of Pro Mim

Arduing HG or older

Aschino Robat Control

Arduino Robot Motor

Arching Gemma

Addatruit Cireuit Playground
Arduino Yun Mini
Archin Incustrial 101
Linino One
Arduing Uno Wit

Indusinal Shiekds boards
Asdbox family
* | M-Duino family
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5. Search for “industrialshields” on the browser.

€ Boards Manager X
Type All ~ | lindustrialshields
industrialshields ~

Boards included in this package:
ARDBOX family, M-Duino family.
Online help

More info

~ | Install

Close
6. Click install (selecting the latest version).
Following this steps you will be able to see now the Industrial Shields Boards:

File Edit Sketch Tools Help

Aute Format coteT
Archive Sketch
shetch_mar! Fix Encoding & Reload

Serial Monitor CtloShiftehd A
Serial Plotter Cot+ShittsL.

WIF101 Firm rare Updater

Board:“Arduina Vi 3 Boards Manager.
port srching AVR Boards.
Get Board Info & Arckano Yun
Arduano/Genuine Uno

Arching Duemilanove or Diecimila
Arckano Nano

Archino/Genuino Mega o Mega 2560
Archino Mega ADK

Arckano Leonardo

Archine Leonardo ETH
Archino/Gentin Micio

Arckano Esplora

Arching Mini

Arckano Ethernet

Archine Fia

Archino BT

LilyPad Arcuine USB

LilyPad Archino

Arckano Pro of Pro Mini

Archino NG or older

Arching Rebot Control

‘Arckano Robot Motor

Archino Gemma
Adatnuit Circuit Playground

Arckano Yon Min
Arching Indlustrial 101
Lig -

Programmer: “Arduno as 158"
Bum Boatioader

inch teelds boards
Ardbox family
M-Duino family

Once it is selected the Ardbox Family or M-Duino family an extra option will appear on Tools:

There, it can be selected the exact model for every family.
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Also there are some examples of programming in File -> Examples -> M-Duino Family.
Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/IndustrialShields/

5 How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
M-Duino Family use USB-B cable.

- Open Arduino IDE interface:

- Select Industrial Shields boards -> M-Duino Family
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- Select the correct M-Duino Board.

@ sketch_mar16a | Arduno 180
File et Sketch Tooks Help

m e - _
r R

Cateshifted
Coteshittst

& Archo Relday HF w/ HW RS-232

- Select correct port.

@ sketch mar16a | Arduino 130

File Eit Sketch Tools Help

m Autn Format culeT
LobE GO _
Serial Monitor CufeShittah &
Senial Plotter Cul+ShiftsL

WAFI101 Fin

Boaret “Arcl
Industrial Shields: “Areiiox Analo

Port B senal port
7 GetBowdinfo COM13 {Ardhino Leonardo)

Programmer: “Archano as ISP
Bun Bootoader

6 How to connect PLC to power supply

- M-Duino Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.
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[ vomensueu]

GND |

I—f ol Aiis |

| I

- Suggested power suppliers

L], li\'['

* Not recommended for industrial applications. The
Jack connector needs to be removed and use the live
and GND connectors.

TRBY

7 M-duino Family Pinout

7.1 A Zone connection

Base E‘
(common unit)
[] |1 Configuration Switch* (see section 8 for
A Zone - . .
Communications configuration.
s 'ng_ | Enabling Communications disable s some
28| ¢ S - 1/0s)
S c 5 5 ARef
D. g o c saw
=0 < T P
5vdc
SCL 21 12C/SS Gnd
0 0 TX0/SS B Communication Pinout
TTL
RX1 19 RX1/SS o0
TX1 18 TX1/SS LA
RX 17 RX2(serial 2) ?; [—
X 16 TX2(serial 2) 7
z- - RS485 Y+ Eg
Y+ - RS485 o B
B- - RS485 At
A+ - RS485 Pin 3
PIN3 3 Arduino Pin b
50 SO 50 SPI 52 SCK
51 Sl 51 SPI Reset Power supply connectors
52SCK | 52 SPI Pnz (24vdc - Gnd)
Reset | Reset SPI GND
Vin5 Vin5 5V By
PIN2 2 Arduino Pin ono g
GND - Gnd 24V )%
GND - Gnd —:l
24vVdc Power Supply E
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OFF ON
SCL/ 126
Base SDA/125
(common unit) Rx1/11.6

TX1/11.5
A Zone

Pin3/106

Pin2/10.5
D53(SD)

FD rsess HD

OFF ON

Arduino Pin
Function

AREF AREF  |Arduino PIN
IOREF2 | IOREF2 |Arduino PIN
IOREF1 | IOREF1 |Arduino PIN

7vdc 7Vdc -
Gnd Gnd GND
3.3vdc | 3.3vdc |Arduino PIN
GND Gnd GND
5vdc 5Vdc -
GND Gnd GND
-
3 W
i § 3 33
L] = on B
4l <fn\ P "
i 1 CE € 2
§ < peser [usBBProgram [ £ oK R
E5 RTC Banery (cR#D) *uSD Socket[J
Ethernet Arduino / Power
Connector Reset button
USB programmer Autoreset
connector

*NOTE: Autoreset. Arduino mega has auto reset when using serial communication code. Set switch to OFF when using
serial communication. When uploading code to Arduino Mega set switch to ON.

Ref. IS.MDUINO.XXX



7.2

B Zone

7.2.1 Analog Shield

B Zone
o5 | £
c 0 o °
58 g s
I | 3 g
o < T
10.12 A5 Analog/ Digital In
10.11 A4 Analog/ Digital In
10.10 A3 Analog/ Digital In
10.9 A2 Analog/ Digital In
10.8 Al Analog/ Digital In
10.7 A0 Analog/ Digital In
(-)10.6/INT1 - GND 10.6
10.6/INT12 3 Interrupt 1 In
()10.5/INTO - GND 10.5
10.5/INT0? 2 Interrupt O In
(-)10.4 - GND 10.4
10.4 26 Digital Input
(-)10.3 - GND 10.3
10.3 25 Digital Input
(-)10.2 - GND 10.2
10.2 24 Digital Input
(-)10.1 - GND 10.1
10.12 23 Digital Input
(-)10.0 - GND 10.0
10.02 22 Digital Input
Top Zone

Analog:
0-10vdc
Digital:
5-24vdc
Digital:

5 - 24Vdc

GND—|

10.12 —ofF
1011 —off}
10.10 —efT¥
109 —offk
10.8 —off
10.7 —efi¥
(-) 10.BANT1H
10.6/NT 1=
() 10.5NTDY
10.5/NT0

(-)10.4—
104 %
(-)10.3—
03 o
()102—
02 o
(-)10.1
01 o
(-)10.0—
100 o

c|lO  Ooiz

Led indicator I/Os state

B Zone

es £ o

5 0 o g

Bc | ¢ 3

= 8 _g =

2 [y
<

GND GND GND
AO0.7% 6 Analog Out
A0.6% 5 Analog Out
A0.51 4 Analog Out
Q/Vdc - External Isolated Out Vdc
COM(-) - External Isolated Out Gnd
QO0.7* 6 Digital/PWM Out
QO0.6! 5) Digital/PWM Out
Q0.51 4 Digital/PWM Out
Q0.4 40 Digital Out
Q0.3 39 Digital Out
Q0.2 38 Digital Out
Q0.1 37 Digital Out
Q0.0 36 Digital Out

OM: DIGITAL
OFF: ANALOG

C§ Digital/PWM

Q/vde

GND
3 |A07
3 |A06
AD5

a/vde

COM(-)
RQo.7
EMNa0.6
Q0.5
Qo4
Qo3
Qo.2
Qo1
- Q0.0

* Note: use correctly configuration for

use this signal
(see user guide)

ANALOG/DIGITAL Inputs

INTERRUPT Inputs (isolated)

DIGITAL Inputs (isolated)

Configuration Switch*
(see section 8 select correct
configuration for outputs).

ANALOG Outputs

VOLTAGE SUPPLY/REFERENCE for
DIGITAL/PWM Outputs (isolated)

PWM/DIGITAL Outputs

1 See section 8 to select suitable switch configuration for (10 to 24Vdc/An-Dig) configurable 1/Os.
2 See section 8 to select suitable switch configuration for enable these connections.
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7.2.2 Relay Shield
B Zone
o8 £ . RO.8
co o =
> 2 c o
Qc = 3]
S o © c RO.7
o < I
R0.8 37 Relay Out RO.G
RO.7 38 Relay Out ©
RO.6 39 Relay Out
R0.5 40 Relay Out
R0.4 24 Relay Out RO.5
A0.2% 6 Analog Out
A0.1% 5 Analog Out
A0.0* 4 Analog Out RO 4
GND GND GND -y
Q0.2¢ 6 Digital/PWM Out gn‘%lgﬂ:
Q0.1% 5 Digital/PWM Out m@_' ¢
Q0.0 4 Digital/PWM Out Digia/Pm
GNDCOM - External Isolated Out Gnd
24VCOM -- External Isolated Out Vdc %
Top Zone _g
Led indicator 1/Os state
o =
(=] ~
£3 & . RO2
] 1] o
32| ¢ 8
=5 = c
5 =}
O ;: [T RO.1
Analog:
RO.3 25 Relay Out (D’-_W:V‘UC
RO.2 22 Relay Out igital:
R0.1 23 Relay Out 5-24vde
GND | GND GND Digral
10.5 A3 Analog/Digital Input 5-24Vdc
10.4 A2 Analog/Digital Input — GND
10.3 Al Analog/Digital Input - 105
10.2 A0 Analog/Digital Input e 104
10.12 3 Interrupt 1 In 2 :gg
()0.1 - GND [0.1 5 S~ 101
10.02 2 Interrupt O In = |-°_|._ 0.1
(-)10.0 - GND 10.0 8 o~ 100
3: ‘-D—h— ()00
85> £2|ao2
5e%  *3%aod
L£3 z5]|Qo.0
Z52
T 82

RELAY Outputs

ANALOG Output (Switch
Configuration)

DIGITAL/PWM Outputs
(isolated)

RELAY Outputs

ANALOG/DIGITAL Inputs
INTERRUPT Inputs (isolated)
Configuration Switch*

(see section 8 to select correct
configuration for outputs).

1 See section 8 to select suitable switch configuration for (10 to 24Vdc/An-Dig) configurable 1/Os.
2 See section 8 to select suitable switch configuration for enable these connections.
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7.3

C Zone

7.3.1 Analog Shield (C Zone)

C Zone
o5 | £
€0 % }
= c o
N < = =
<5 3 g
o < T
11.12 All Analog/ Digital In
11.11 A10 Analog/ Digital In
11.10 A9 Analog/ Digital In
11.9 A8 Analog/ Digital In
11.8 A7 Analog/ Digital In
11.7 A6 Analog/ Digital In
(-)I1.6/INT1 NC GND I1.6
11.6/INT12 19 Interrupt 1 In
(-)I1.5/INTO NC GND 11.5
11.5/INT0? 18 Interrupt O In
(-)11.4 NC GND 11.4
11.4 il Digital Input
(-)11.3 NC GND 11.3
11.3 30 Digital Input
()12 NC GND I1.2
11.2 29 Digital Input
()11 NC GND I1.1
11.1 28 Digital Input
(-)I11.0 NC GND I1.0
11.0 27 Digital Input

Led indicator I/Os state

—offJo—
Analog:
0-10vdc
Digital:
5-24Vdc

o
Digital:
5-24Vdc

) M 6ANTA,
11.6/INT4o"
() H.SINTS,
11.5/NT5~

(1A
4 o
(1.3
M3 o
1.2
M2 o
A
M o
() 11.0—
0

C Zone e
2%la1s
z5|015)

o =
c 9 £ )
S8 | = 5 T
2: g < 8 @Tngila\
o _g E Q/f Vdc
(@) 4 —
< Fmr
GND GND GND
Al.7* 7 Analog Out .
Al.6% 9 Analog Out 2
A1.5! 8 Analog Out 2
Q/Vdc - External Isolated Out Vdc 3
COM(-) - External Isolated Out Gnd €
Q1.7} 7 Digital/PWM Out 2
Q1.6t 9 Digital/PWM Out .
Q15! 8 Digital/PWM Out gst
Q1.4 45 Digital Out 832
Q1.3 44 Digital Out ot g
Q1.2 43 Digital Out 238
Q1.1 42 Digital Out - 7
Q1.0 41 Digital Out

ANALOG/DIGITAL Inputs

INTERRUPT Inputs (isolated)

DIGITAL Inputs (isolated)

Configuration Switch*
(see section 8 select correct
configuration for outputs).

ANALOG Outputs

VOLTAGE SUPPLY/REFERENCE for
DIGITAL/PWM Outputs (isolated)

PWM/DIGITAL Outputs

1 See section 8 to select suitable switch configuration for (10 to 24Vdc/An-Dig) configurable 1/Os.
2 See section 8 to select suitable switch configuration for enable these connections.
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7.3.2 Relay Shield C Zone

B Zone
oS g f I
€5 Do- =
3¢ | g :
T C =] o
=Q e 5
O < I RELAY Outputs
R17
R1.8 42 Relay Out
R1.7 43 Relay Out
R1.6 44 Relay Out R16
R1.5 45 Relay Out
R1.4 29 Relay Out
Al1.2t 11 Analog Out R1.5
Al.1t 10 Analog Out
A1.0t 8 Analog Out
GND GND GND R14
Q1.21 11 Digital/PWM Out ) o ANALOG Output (Switch
Q1.1t 10 Digital/PWM Out Analog H H
o1.0t 8 Digital/PWM Out %Emmc Conflguratlon)
GNDCOM - External Isolated Out Gnd DtaEm:
24VCOM = External Isolated Out Vdc DIGITAL/PWM Outputs
(isolated)
Top Zone
Led indicator I/Os state :l_
= RELAY Outputs
2o E v R1.2 P
S5 0
32| ¢ g
=5 3 5 R11
o B o —IDe—
< Analog:
0-10vdc
R0O.3 30 Relay Out Digital:
RO.2 27 Relay Out 5-2avac
RO.1 28 Relay Out [_).\\\-ta\
GND | GND GND o v
10.5 A9 Analog/Digital Input — GND
10.4 A8 Analog/Digital Input N "5
10.3 A7 Analog/Digital Input b 1n4 ANALOG/DIGITAL Inputs
10.2 A6 Analog/Digital Input 8 ” g
10.12 19 Interrupt 1 In 5 S~ 111 INTERRUPT Inputs (isolated)
(9)10.1 = GND 10.1 € rJ_p— (-1
10.0? 18 Interrupt O In E; 7o 110 . . .
()10.0 - GND 10.0 g i ano Configuration Switch*
583 L8[ne (see section 8 to select correct
g 53|Q12 . .
3%y 3|1y configuration for outputs).
g3 zk|aio
H 238

1 See section 8 to select suitable switch configuration for (10-24Vdc/An-Dig) configurable I/Os.
2 See section 8 to select suitable switch configuration for enable these connections.
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7.4

7.4.1 Analog Shield (D Zone)

D Zone

L
Analog:
0-10vdc
Digital
9 -24vdc

o
Digital:
5-24vde

() [2.6ANT2
12.6/INT2+
() IZ5ANT3y
12.5/INT3+

() 12.4—
124
(=) 12.3—
123 -
(=) 12.2—
122 o
=) 12,1
121 o
(=) 12.0—
120 %

ANALOG/DIGITAL Inputs

INTERRUPT Inputs (isolated)

D Zone
o5 | £
£3 Do- c
= c o
N < = =
2 |3 g
= 8 z 3
12.12 Analog/ Digital In
12.11 - Analog/ Digital In
12.10 A15 Analog/ Digital In
12.9 Al4 Analog/ Digital In
12.8 A13 Analog/ Digital In
12.7 Al12 Analog/ Digital In
()I2.6/INT1 | NC GND 12.6
12.6/INT12 21 Interrupt 1 In
()I2.5/INTO | NC GND 12.5
12.5/INT0? 20 Interrupt O In
()I2.4 - -
12.4 - =
()12.3 NC GND 12.3
12.3 35 Digital Input
(2.2 NC GND 12.2
12.2 34 Digital Input
(2.1 NC GND 12.1
12.1 33 Digital Input
()12.0 NC GND 12.0
12.0 32 Digital Input
Top Zone
e
o™clo ollo 0 0 ©
" 4 aaf 5 ax
Led indicator 1/Os state
D Zone
=) £ o
5 0 o g
Bc | ¢ 3
= 8 _g S
4 (s
<
GND GND GND
A2.7 - =
A2.6% 13 Analog Out
A2.51 12 Analog Out
Q/Vdc - External Isolated Out Vdc
COM(-) - External Isolated Out Gnd
Q2.7 - -
Q2.6 13 Digital/PWM Out
Q2.5! 12 Digital/PWM Out
Q2.4 - -
Q2.3 49 Digital Out
Q2.2 48 Digital Out
Q2.1 47 Digital Out
Q2. 53 Digital Out

OFF; ANALDG
o002

ON: DIGITAL

* Note: use correctly configuration for

use this signal
(see user guide)

pRRS
g

DIGITAL Inputs (isolated)

Configuration Switch*
(see section 8 select correct
configuration for outputs).

ANALOG Outputs

VOLTAGE SUPPLY/REFERENCE for
DIGITAL/PWM Outputs (isolated)

PWM/DIGITAL Outputs

1 See section 8 to select suitable switch configuration for (10-24Vdc/An-Dig) configurable I/Os.
2 See section 8 to select suitable switch configuration for enable these connections.
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7.4.2 Relay Shield D Zone
D Zone
oo 'nE_ - R2.8
€5 o =
ac £ S
<5 § e R2.7
o < I
R2.8 47 Relay Out R2.6
R2.7 48 Relay Out
R2.6 49 Relay Out
R2.5 - - NC
R2.4 34 Relay Out
A2.2 - -
A2.1% 13 Analog Out R2 4
A2.0! 12 Analog Out ey
GND GND GND Anglog:
Q2.2 . Digital/PWM Out g
Q2.11 13 Digital/PWM Out atva
Q2.0 12 Digital/PWM Out
GNDCOM - External Isolated Out Gnd
24VCOM -- External Isolated Out Vdc
Top Zone
l o
00 O
=~ =
o 4 o
Led indicator I/Os state
D Zone R2.3
25 | « . R22
S5 0 o <
a2 o 2
s c £ e R2.1
o =] 5 -
o B s ~D—
Z Analog:
0-10Vidc
R2.3 35 Relay Out g'?gil\'m
R2.2 32 Relay Out —~
R2.1 33 Relay Out Digital
GND GND GND 5 -24vdc
12.5 Al5 Analog/Digital Input — GND
12.4 Al4 Analog/Digital Input 5 125
12.3 A13 Analog/Digital Input 5 :ﬁg
12.2 A12 Analog/Digital Input T 122
12.1% 21 Interrupt 1 In 2 ri‘r— 121
O2.1 = GND 2.1 5 S L
12.0* 20 Interrupt O In Z ra—h— ()12.0
(-)12.0 - GND 12.0 2 o)
T 2 Lg[ne
20 * EE Q21
§§ s zi|az0
288

RELAY Outputs

ANALOG Output (Switch
Configuration)

DIGITAL/PWM Outputs
(isolated)

RELAY Outputs

ANALOG/DIGITAL Inputs
INTERRUPT Inputs (isolated)

Configuration Switch*

(see section 8 to select correct

configuration for outputs).

1 See section 8 to select suitable switch configuration for (10-24Vdc/An-Dig) configurable I/Os.
2 See section 8 to select suitable switch configuration for enable these connections.
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8 Switch configuration

8.1 A Zone: Communications

LEFT ZONE
Switch Analog Shield Relay Shield
ON | OFF ON | OFF
D ZONE
SCL/12.6 12.6 SCL 2.1 SCL
SDA/I2.5 12.5 SDA 12.0 SDA
C ZONE
RX1/11.6 11.6 RX1 1.1 RX1
TX1/11.5 11.5 TX1 11.0 TX1
B ZONE
Pin 3/10.6 10.6 Pin 3 10.1 Pin 3
Pin 2/10.5 10.5 Pin 2 10.0 Pin 2
uSD & RS-485
D53(SD) D53(SD) Q2.0 D53(SD) -
FD RS-485 HD HD FD HD FD
!0 FF ON . *Although the Serigraphy of the
f] SCL/ 2.6 :‘ ‘j‘ 1 ‘ Switches will only reference to the
SDA /12.5 o » | Analog Shields, if a Relay Shield is
Rx1/ 11.6 . o™ ..\ connected the IX.6 changes for IX.1
R 4 and the IX.5 changes for IX.0. Being
Tx1/11.5 - - =4 X a value inside of [0..2].
R <
Pin3/10.6 a
Pin2/10.5 | RSN
053(sD) | IS
FD mrssss HD| Jis
i L |

4. SCL/12.6: Choosing between SCL or the input 12.6. If this switch is ON, it enables the 12.6
input and disables the SCL. If this switch is OFF, it enables SCL and disables 12.6. If it is a Relay
Shield 12.6 is changed for 12.1

3. SDA/12.5: Choosing between SDA or the input 12.5. If this switch is ON, it enables the 12.5
input and disables the SDA. If this switch is OFF, it enables SDA and disables 12.5. If it is a Relay
Shield 12.5 is changed for 12.0

2. RX1/11.6: Choosing between RX1 or the input I1.6. If this switch is ON, it enables the 1.6
input and disables the RX1. If this switch is OFF, it enables RX1 and disables I1.6. . If it is a Relay
Shield 11.6 is changed for 11.0

1. TX1/11.5: Choosing between TX1 or the input 11.5. If this switch is ON, it enables the 11.5
input and disables the TX1. If this switch is OFF, it enables TX1 and disables I1.5. . If it is a Relay
Shield 11.5 is changed for 11.0
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4. Pin 3/10.6: Choosing between Pin 3 or the input 10.6. If this switch is ON, it enables the 10.6
input and disables the Pin 3. If this switch is OFF, it enables Pin 3 and disables 10.6. If it is a
Relay Shield 10.6 is changed for 10.1

3. Pin 2/10.5: Choosing between Pin 2 or the input 10.5. If this switch is ON, it enables the 10.5
input and disables the Pin 2. If this switch is OFF, it enables Pin 2 and disables 10.5. If it is a
Relay Shield 10.5 is changed for 10.0

2. D53(SD): If this Switch is ON, it enables the Chip Select of the microSD socket. If this switch is
OFF, it disables the Chip Select of the microSD socket.

*If the D Zone is an Analog Shield, Q2.0 is also related with D53. Being D53 in ON Mode the Q2.0 MUST NOT be
used because it can corrupt the microSD. In order to use the Q2.0 the switch D53(SD) must be set to OFF.

*If the D Zone is a Relay Shield there is no problem and it can be set always to ON. Q2.0 of the Relay Shield is
related with D12, so it doesn’t affect in any case to the microSD. The pin53 is not connected at all to any
input/output, it only connects to the uSD chip select.

1. FD RS-485 HD: Choosing between SCL or the input 12.6. If this switch is ON, it enables the
12.6 input and disables the SCL. If this switch is OFF, it enables SCL and disables 12.6.

LEFT ZONE orf =
SWITCH ON OFF
NC - -
NC - - RTC SCL
RTC SCL RTC - RTC SDA
RTC SDA RTC - —

1. RTCSDA: This switch enables the communication to communicate with the RTC using
12C. Having this switch in ON mode it actives this communication, whereas if it is in
OFF mode it disables the 12C to reach the RTC.

2. RTC SCL: This switch enables the communication to communicate with the RTC using
12C. Having this switch in ON mode it actives this communication, whereas if it is in

OFF mode it disables the 12C to reach the RTC.

3. NC: Not connected. This switch is not connected to anything, it doesn’t matter if it is in
ON mode or OFF mode.

4. NC: Not connected. This switch is not connected to anything, it doesn’t matter if it is in
ON mode or OFF mode.
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8.2  Analog Shield

B ZONE C ZONE D ZONE
SWITCH | ON | OFF SWITCH | ON | OFF SWITCH | ON | OFF
NC - - NC ; - NC - -
Q0.7 | Q0.7 |A07 Ql7 |Ql.7|AL7 Q2.7 ] ;
Q0.6 | Q0.6 |A06 Ql6 |Qlé6|AL6 Q2.6 |Q2.6|A26
Q0.5 | Q0.5 | A0S Ql5 | Qls | ALS Q2.5 |Q25]|A25

NC

3§ Q17

22|a1s

zklQ1s

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF

it can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide

this analog output is represented with AX.X, being X any number of the tables above.

8.3  Relay Shield
B ZONE C ZONE
SWITCH ON | OFF SWITCH ON | OFF
NC - - NC - -
Q0.2 Q0.2 | A0.2 Q1.2 Q1.2 | A1.2
Q0.1 Q0.1 | AO.1 Q1.1 Q1.1 | A1l
Q0.0 Q0.0 | AO.O Q1.0 Q1.0 | A1.0
" NC 18 NC
: Q0.2 53[012
*82| 0.1 *82|a11
85(0.0 z5(a1.0

D ZONE
SWITCH ON | OFF
NC - -
Q2.2 - -
Q2.1 Q2.1 | A2.1
Q2.0 Q2.0 | A2.0
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For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it
can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide
this analog output is represented with AX.X, being X any number of the tables above.

9 M-Duino Arduino I/0s 5V pins

The M-Duino has some of the Mega board pins available. These pins can be programmed
according to Arduino features such as I/Os operating at 5V or any additional features present
in the pins (for example 12C communication in pins SCL and SDA).

The Arduino board available pins are summarized in the table below. In order to access some
of this pins the configuration switch must be set to OFF position (see section 8).

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TX0 1
RX1 19 Communication switch: OFF
TX1 18 Communication switch: OFF
RX3 15
TX3 14
Pin 3 3 Communication switch: OFF
Pin 2 2 Communication switch: OFF

IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Mega board.

10 A Zone Features: Communications & RTC & uSD

10.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16
and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not
matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232
implementation.
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10.2 RS-485

For RS485 communication protocol the defined Arduino Mega pins are showed in the chart
below.

Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects in this
communication. The RS-485 protocol will be always enabled, the only switch that affects is the
one called “FD rs-485 HD"” (See Section 9). This switch makes the choosing between RS-485
Half Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

10.3 1I2C

12C communication DOES NOT REQUIRE a pull-up resistor. The pull-up resistor is already
implemented in the PCB.

12C communication is configured by switches, so the switches must be configured in order to
enable the 12C communication.

Switch Analog Shield Relay Shield
ON | OFF ON | OFF
D ZONE
SCL/12.6 12.6 SCL 12.1 SCL
SDA/I2.5 12.5 SDA 12.0 SDA

To enable 12C the switches SCL/12.6(12.1) & SDA/12.5(12.0) must be set to OFF mode. In this
mode the inputs are totally disabled and the 12C is now enabled.

Industrial Shields does not provide any library to implement the 12C as it can be used the
standard library of Arduino called Wire.
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10.4 SPI

The M-Duino pins used for the SPI bus are summarized in the table below. For SPI bus MISO,
MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,
each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 S0 50
MOSI 518l 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX1/TX1/RX3/TX3/Pin2/Pin3 | 21/20/1/0/19/18/15/14/2/3

Check the switch configuration at section 8 to enable SS pins.

10.5 TTL

M-Duino has three TTL ports, RX0/TX0 and RX1/TX1, RX3/TX3. TTLO is accessed with the
function Serial (pins 0 and 1 of the Arduino Mega). TTL1 is accessed with the function Seriall
(pins 18 and 19 of the Arduino Mega). TTL3 is accessed with the function Serial3 (pins 14 and
15 of the Arduino Mega).

If using TTL3, the RS-232 communication protocol is totally disabled as it also uses the Serial 3.

In order to use the TTL pins the configuration of the switches have to be the following one:

Switch Analog Shield Relay Shield
ON | OFF ON | OFF
C ZONE
RX1/11.6 11.6 RX1 1.1 RX1
TX1/11.5 11.5 TX1 11.0 TX1

If the switches RX1/11.6(11.1) & TX1/11.5(11.0) are in OFF mode, the RX1/TX1 will be enabled. In
order to use TTL3 these switches must be in OFF mode.

10.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the compatible IC compatible
with Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible
with the M-DUino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS
Arduino Mega pin 10).

Using the boards of Industrial Shields, there is a library that simplifies the Ethernet
implementation called Ethernet2.
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10.7 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the 12C protocol
communication, so it is required to have enabled the 12C protocol.

4 switches have to be configured in order to enable the RTC features:

LEFT ZONE
SWITCH ON OFF | RTC SCL & RTC SDA must be set to ON mode to
EE . - enable the I12C wires to the RTC. If they are in OFF

RTC SCL RTC : mode, the Arduino won’t communicate with the RTC.
RTC SDA RTC -
Switch Analog Shield Relay Shield

ON OFF ON OFF I2C must be enabled in order to
SCL/12.6 12.6 SCL 2.1 SCL communicate with the RTC. See
SDA/12.5 12.5 SDA 12.0 SDA section 11 12C to enable it.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation
called RTC.

10.8 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol
is always enabled, as there are no switches that configure it. However there is a switch that
must be placed to ON mode in order to communicate with the uSD:

D53(SD): If this Switch is ON, it enables the Chip Select of the microSD socket. If this switch is
OFF, it disables the Chip Select of the microSD socket.

*If the D Zone is an Analog Shield, Q2.0 is also related with D53. Being D53 in ON Mode the Q2.0 MUST NOT be
used because it can corrupt the microSD. In order to use the Q2.0 the switch D53(SD) must be set to OFF.

*If the D Zone is a Relay Shield there is no problem and it can be set always to ON. Q2.0 of the Relay Shield is
related with D12, so it doesn’t affect in any case to the microSD. The pin53 is not connected at all to any
input/output, it only connects to the uSD chip select.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of
the PLC, it is required to open the plastic found in the frontal part and the socket is located
under the supply of the Arduino.

LEFT ZONE
Switch Analog Shield Relay Shield
ON | OFF ON | OFF
usD
D53(SD) | D53(sD) | Q2.0 |Ds3(sp)| -
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Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation
called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to
select the Chip Select of the uSD chip.

11 I/0 technical details:

Digital Output Waveform:

P+ 244 ims | Fg———]
v

DIGITALOUT

DIGITAL OUT

PWM Waveform:
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]

AMALOGOUT

ANALDG OUT

ARDLINO OUT

2. [al) i CH1 £ A.

Analog /Digital input Turn-on:
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12 Typical Connections

DIGITAL ISOLATED INPUT

E GND (-)10.0
5M12/24v 10.0

GND
@ POWER
1224V B  oemaw

Download the MDUINOG LAYOUT:
From: www.industrialshields.com

DIGITAL NO-ISOLATED INPUT

-)10.0

o——— 10.0

GND
e POWER
12/24v [ DIGITAL IN

Download the MDUING LAYOUT:
;_’ From: www.industrialshields.com j

DIGITAL/ANALOG INPUT
{Digital)

40/07 10.7

GND
@ POWER
12/24v . | DIGITAL/ANALOG IN

Download the MDUING LAYOUT:
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DIGITAL/ANALOG INPUT
{Digital with external
alimentation)

@— 512124V 10.7
GND
GND
POWER
12/24v . DIGITAL/ANALOG IN
Download the MDUING LAYOUT:
DIGITAL/ANALOG INPUT
(Analog)
o-10V
Aoéq‘”%oi 0.7
GND
@ POWER
12/24V . | DIGITAL/ANALOG IN
Download the MDUING LAYQUT:
DIGITALIANALOG INPUT
(Analog with external
alimantation)
o-10V
@ 5112124V M 0.7
GND
GND
@ POWER
12124V . DIGITALAANALOG IN

Downioad the MDUING LAYOUT:
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DIGITAL ISOLATED OUTPUT

Q/vde 51224V
!
COM () GND E’ A

ALWAYS
CONNECTED
Q0.0
GND =
POWER VOUT = Q/Vdc
12/24V | DIGITAL OUT
Downigad the MDUING LAYOUT:
From: www.indusiriafshiskds.com
DIGITAL NON-ISOLATED
QUTPUT
Q/ Vde
COM (-) @
ALWAYS
CONNECTED
Q0.0
GND -
E 3 POWER VOuT=Q/Vdc
12i24v 0 owemaLour
Downfoad the MDUING LAYOUT: 5
From: www.industrigishields.com
DIGITAL / PWM ISOLATED
OUTPUT
* See the swifch
configutarion (ON)
Q/Vde 512124V E @
COM {-) GND
ALWAYS
T GONNECTED
Qo5
GND -
POWER VOUT=Q/Vde
1224V ' " DIGITALPWM OUT

Download the MDUINO LAYOUT:
i From: www.industrialshields.com i
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DIGITAL / PWM
NON-ISOLATED QUTPUT

/ﬁ\ * See the switch
070 g O] 06 configutarion (ON)
8
05| &[0 04
Q/Vde
03|0 g Of0z2 &
: COM (=)
|0~ CJoo ALWAYS
NC|O O eaz CONNECTED
la e Q0.5
GND =
& POWER VOUT = Q/ Vde
12224v i " DIGITALIPWM OUT
Download the MDUING LAYOUT:
e ——— AN

ANALOG OUTPUT

* Analog Outs no led
indicator

/6\ * See the switch

070 g 0|08 configutarion (OFF}

[=)
05 @ 04 GND

—/\j 0-10v
02 AOS —

GND
POWER

12724V ANALOG OUT

Download the MDUINO LAYOUT:
i From: www.industriaishieids.com

Ref. IS.MDUINO.XXX



13 Connector details:

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502
from Phoenix contact. MCO0,5/10-G-2,5THT

For 1/0 and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference | MC 0,5/10-G-2,5 THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1
https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1881406&library=usen&tab=1#General

14 Mechanical Characteristics

- Dimension M-duino Family:

129
114

- DIN Rail mounting

Profilato a cappello TH 35-7,5 Profilato o coppello TH 35-15
Top hat rail TH 35-7,5 Top hat rail TH 35-15
15 5
158,
1=0.04
15°
. RO8
R12
——— 303 k08
o~ L
=
AL
ISR 1004
v Sezione A/ Section A k12
0.3 max -~ 22 min. finoa / To 2,5 max
S| e
+
&1 Serone A/ Sedion A
CARATTERISTICHE METODO  UNMA'  BLEND FEATURES TEST UNITS BLEND
DI MISURA _PC/ABS METHOD PUABS
Mecconiche  Reisoreng k ST D38 MPg 8 Mechanical test Resistynce i tensl stess o v ASTDE38 MRy 8
Resighieo o tazioneo nitwg ST DS MPg L] Tonglostength ASTMDE38 MR L]
Alngomento o rotn KSTM0638 % 59 Utimonts ek ASTMDS38 % 59
Modulo in fesione KSTHDTH  MPo 2694 Pling modules ASTHDT0 MR yiiil}
Provo l20d conintoglio 5018014 Xy 55 rod test noiched 15018014 Xyim' 55
Termiche Temp di nmmolinento Viot, mekdoB  ASTM DIS25  °C 114 Thermal fest Vit sodbening temperotwe method B ASTRDISES 114
Temperotu Ricto 1 81 My KTN068  °C /A Rebecting temperatue 181 WPy ASTMDS48  °C 9
Fisiche Peso spedio KSTHOT?  gfand i Physical test  Specc guviy ASTRDTR__ gand 121
Ritie nello stompo KTADISS % 0406 Hould shrnk ASTMD9SS % 0406
Mot Flow Index 260°C - 98N KUADIZ8 /10" 1A} Mt Flow Ind 260°C - 98N ASTMDIZ8 g0’ 11
Comportamento Aukesinguerzs (i i pesor) 4 - V-0(08) Flame test Seff etinguisher thidkness in mm) o4 - V-0(08)
alla fiomma __Fio Inandescen 37 mm %521 °C 960 ndescents thieod 32 mm 169521 C 960
Ialtronic si riserva il diritto di modificore il moteriole con cui realizzo i propei prodotti Ialtronic con operate ony change of the moterials without being obliged to forewarn.
senzo obbligo di preawiso.
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruités de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com
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